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1 Introduction
Ceci n’est pas du tout un cours complet de montage vidéo. Il s’agit d’un document de prise en main, conçu

rapidement pour permettre de compenser l’absence de cours/TD/TP lors du confinement. Il manque un grand
nombre d’éléments et il est impératif que vous jouiez avec ce logiciel pour le prendre en main et découvrir les
possibilités. Vous pouvez me poser des questions par mail, et on peut s’arranger pour résoudre vos problèmes de
montage à distance. N’hésitez surtout pas si vous avez des questions. Il me permettra de modifier et compléter
ce document.

2 Installer OpenShot Video Editor
OpenShot Video Editor est un logiciel libre (basé sur python), gratuit et multiplateforme : vous pouvez

l’installer que vous soyez sur Windows, Linux ou Mac OS X. Vous pouvez le télécharger sur https://www.
openshot.org/fr/download/. Choisissez le système d’exploitation puis cliquez sur Téléchargement.
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Figure 1 – Page de téléchargement d’OpenShot Video Editor.

2.1 Windows
Double-cliquez dessus et suivez les instructions à l’écran. Une fois terminé, OpenShot sera installé et

disponible dans votre menu Démarrer.

2.2 Mac OS X
Double-cliquez sur le fichier .dmg téléchargé, puis faites glisser l’icône de l’application OpenShot dans

votre raccourci Applications. Ceci est très similaire à la façon dont la plupart des autres applications Mac sont
installées. Lancez maintenant OpenShot (clique droit → ouvrir).

2.3 Linux
Une fois l’AppImage téléchargée, faites un clic droit sur le fichier AppImage, choisissez Propriétés et marquez

le fichier comme exécutable. Ensuite, double-cliquez sur l’AppImage pour la lancer.

3 Découverte et Prise en main
Tout d’abord, il existe sur le site un guide (en anglais), que vous pouvez trouver ici : https://www.

openshot.org/fr/user-guide/. Ce guide étant en anglais, je vous invite à laisser la langue par défaut pour
OpenShot afin de plus facilement suivre les indications.

3.1 La structure en panneaux
Lorsque vous ouvrez Openshot, la première chose à faire est de vous mettre dans la vue avancée. Pour cela,

vous cliquez sur le menu view :
• View → Views → Advanced View

Vous obtenez alors quelque chose qui ressemble à la Fig.2. L’écran se divise alors en différents panneaux
(encadrés en rouge sur la figure), que vous pouvez fermer en appuyant sur la croix en haut à droite de chacun
d’entre eux. Vous pouvez modifier leur taille en jouant sur les ’poignées’ situées entre chaque panneau (cerclés
en vert sur la figure). Vous pouvez aussi les déplacer : cliquer sur l’icone à gauche de la croix (petit rectangle),
puis faites glisser la fenêtre qui s’est détaché à l’endroit souhaité. A tout moment vous pouvez refaire apparaître
tous les panneaux en cliquant sur :
• View → Views → Show All
Pour l’instant nous allons nous intéresser uniquement à 4 panneaux essentiels :
• Project Files : l’ensemble des fichiers à utiliser seront ici : images, vidéos et sons. Il est indiqué par le

numéro 1 dans la Fig.3.
• Timeline : c’est la ligne du temps. C’est là que vous allez intervenir le plus souvent. Il est indiqué par

le numéro 2 dans la Fig.3.
• Properties : propriétés de la ressource utilisées : image, vidéo ou son. Vous modifierez donc ici la taille,

la forme, la transparence, la position, les déplacement de vos images. Il est indiqué par le numéro 3
dans la Fig.3.

2

https://www.openshot.org/fr/user-guide/
https://www.openshot.org/fr/user-guide/


Figure 2 – Vue avancée : en rouge les panneaux constituant la structure, en vert les ’poignées) permettant
d’ajuster la taille de chaque panneau.

• Video Preview : panneau de visualisation montrant le rendu de l’image sur laquelle vous êtes en train
de travailler, ou de la vidéo. Il est indiqué par le numéro 4 dans la Fig.3.

Si vous fermez les panneaux inutiles, vous vous retrouvez donc plus ou moins dans la configuration #1 illustrée
Fig.3.

Figure 3 – Configuration #1 avec 4 panneaux : 1-
Project Files, 2-Timeline, 2-Properties et 4-Video Pre-
view.

Figure 4 – Panneau Project Files : importer en cli-
quant sur le signe + vert en haut à gauhce de la figure,
ou avec un clique droit → + Import Files...

3.2 Le panneau ’Project Files’
Pour importer vos ressources (image, vidéo ou son), vous pouvez soit cliquer sur le signe + vert dans la

barre horizontale tout en haut, soit cliquer droit dans le panneau ’Project Files’ → + Import Files... (voir
Fig.4.)Vous sélectionnez ensuite les fichiers dont vous aurez besoin pour la suite.
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Figure 5 – Panneau ’Timeline’

3.3 Le panneau Timeline
Ce panneau est constitué de plusieurs pistes (Track), au nombre de 5 sur la Fig.5. Parcourons les boutons

en haut à gauche de gauche à droite :
• le signe + vert permet d’ajouter des pistes. Il est également possible d’ajouter des pistes en dessous ou

au dessus d’une autre en cliquant sur le chevron tout à gauche de chaque piste (voir le cercle vert à
gauche de ’Track 2’ sur la Fig.5).

• Le second bouton avec un aimant, une fois coché, il permet de coller les vidéos les unes aux autres :
laissez le cliqué (il l’est par défaut) car c’est très pratique.

• Le bouton suivant est l’outil ciseaux : vous l’utiliserez lorsque vous voudrez découper une vidéo en
plusieurs morceaux.

• le bouton suivant permet d’insérer un marqueur à une position dans le temps : il suffit de placer le
curseur (qu’on verra plus bas) à une position précise et de cliquer sur ce bouton pour ajouter un
marqueur temporel.

• les deux boutons qui suivent permettent de naviguer entre les marqueurs temporels crée avec le bouton
précédent.

• le bouton suivant permet de centrer la timeline sur la positions actuelle du curseur (qu’on verra plus
bas).

• la barre de zoom temporel qui suit permet de zoomer sur l’échelle de temps : soit en bougeant le
curseur du milieu, soit en cliquand sur les signes + et - de chaque coté. C’est utile de zoomer pour
affiner précisément la position dans le temps de vos images, sons et vidéos, et de dézoomer pour avoir
une vue d’ensemble de votre projet.

Le curseur permet de naviguer dans le temps. Il est possible de le bouger en faisant glisser le curseur entouré
en blanc dans la Fig.5. Le panneau de visualisation (Video Preview) montrera alors l’image à cet instant précis.
Le temps précis associé à la position du curseur est indiqué tout à gauche sous la forme 00 : 00 : 00 : 01, il
s’agit de des heures, des minutes des secondes et du numéro d’image (de 1 à 25 car vous serez à 25 images par
secondes). Il passe donc de 00 : 00 : 01 : 25 à 00 : 00 : 02 : 01 !

En cliquant sur le chevron à côté de chaque piste (voir cercle vert à gauche de ’Track 2’ sur la Fig.5), vous
pouvez renommer chaque piste. Je vous conseille de reserver les deux premières pistes pour le son et les autres
pistes pour les vidéos. Pour ajouter des sons et des vidéos, vous pouvez les glisser depuis le panneau ’Project
Files’ sur une des pistes. Pour que l’on puisse partir du même point de départ pour la suite, voici les consignes :
• renommer la piste ’Track 1’ en ’son1’ et la piste ’Track 2’ en ’son2’
• renommer la piste ’Track 3’ en ’video1’, la piste ’Track 4’ en ’video2’ etc...
• glissez un fichier de son sur la piste ’son1’
• glissez un fichier vidéo sur la piste ’video1’
• glissez un fichier image sur la piste ’video2’. Vous remarquerez que la durée est fixée par défaut (et

arbitrairement) à 10 secondes. On pourra évidemment modifier cela.
• zommer au maximum l’échelle temporelle
• placez le curseur sur la première image de la cinquième seconde (00 : 00 : 05 : 01).
• cliquez ensuite sur l’image de la piste ’video2’ : elle devient entourée de rouge : c’est la ressource active,

et vous avez les informations relatives à cette ressources dans le panneaux ’Properties’.
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Vous aurez alors quelque chose qui ressemble à la configuration #2 de la Fig. 6. Vous voyez dans le panneau
de visualisation que l’image est au dessus de la vidéo de la piste ’video1’ : les pistes sont superposées les unes
aux autres comme des calques. Si vous faites glisser la vidéo de la piste ’video1’ à la piste ’video3’, celle ci sera
au dessus de l’image et vous ne verrez donc plus l’image.

Figure 6 – Confugration #2 Figure 7 – Confugration #3

3.4 Panneau ’Properties’
Dans le panneau properties vous avez toutes les propriétés de la ressource sélectionnée dans la timeline.

Voici les paramètres les plus importants (attention de ne pas y toucher pour l’instant, il y a une subtilité...) :
• Alpha : c’est la transparence. Sa valeur va de 1 (complètement opaque) à 0 (complètement transparent)
• Crop Height : c’est le découpage de la hauteur. Sa valeur va de 1 (image entière) à 0 (totalement coupée)

en passant par 0.5 qui enlève la moitié inférieure de l’image.
• Crop Width : pareil pour la largeur
• Enable Audio : permet de couper le son des vidéos (les options possibles s’obtiennent en cliquant droit)
• Enable Video : permet de couper la vidéo (les options possibles s’obtiennent en cliquant droit)
• End : permet de raccourcir une vidéo, ou d’allonger la durée de présence d’une image. Si vous ajustez

la valeur à une durée plus grande de la vidéo, c’est la dernière image de cette vidéo qui restera affichée
uniquement.

• Location X ou Y : permet de bouger la position de la vidéo ou de l’image en horizontal ou vertical.
• Position : c’est la position du début de la ressource (en seconde)
• Rotation : c’est la rotation en dégrés de la ressource.
• Scale : comment ajuster la taille de l’image à la taille de l’écran (les options possibles s’obtiennent en

cliquant droit). Best Fit : ajuste au maximum en hauteur ou en largeur. Crop : ajuste l’échelle pour
remplir tout l’écran en découpant la partie qui dépasse. Stretch : étire l’image pour ajuste la taille de
l’image à la taille de l’écran (déformation de l’image).

• Scale X ou Y : modifie la taille horizontale ou verticale de l’image.

Attention ! Lorsque vous modifiez la propriété d’une image, vous la modifiez à un instant t défini par le
curseur. Ces valeurs vont donc rester constante à partir de ce temps là. Mais ces valeurs vont changer entre le
début de la vidéo/image et ce temps t. Au début de la vidéo, les valeurs sont celles d’origine, et OpenShot va
donc modifier ces valeurs continument entre le début de la vidéo/image et ce temps t. Faisons l’essai :
• placer le curseur est à 00 : 00 : 05 : 01.
• selectionner l’image sur la piste ’vidéo2’.
• modifier le paramètre de transparence ’Alpha’ à 0.5
• modifier la position en X à 0.39 et Y à -0.38
• modifier l’échelle en X et Y à 0.25

Les paramètres changés sont alors surlignés en vers, et un (très) petit trait vert apparait au croisement sur
curseur et de la piste ’video2’ sur le panneau ’Timeline’ (voir le cercle blanc sur la Fig. 7). L’image est plus
petite et située en haut à gauche et semi-transparent sur la panneau ’Video Preview’ comme illustré Fig. 7.
Déplacez maintenant le curseur APRÈS 00 : 00 : 05 : 01 : les valeurs ne sont plus surlignées en vert mais
en bleu : cela indique que ce ne sont pas les valeurs initiales par défaut, mais qu’elle ont été changées, mais
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elles sont égales aux valeurs entrée à la position 00 : 00 : 05 : 01. Déplacez maintenant le curseur AVANT
00 : 00 : 05 : 01 : les valeurs ne sont plus surlignées en vert non plus mais en bleu : les valeurs changent
linéairement entre la valeur à 00 : 00 : 00 : 01 (début de l’image) et la position 00 : 00 : 05 : 01 où l’on a entré
les nouvelles valeurs.

L’image à la position 00 : 00 : 05 : 01 est appelée image clé ou Keyframe. Vous pouvez supprimer ces images
clés. Pour cela :
• placer le curseur à la position de l’image clé (les valeurs dans le panneau ’Properties’ deviennent alors

vertes).
• Cliquer droit sur le paramètre surligné en vert dans le panneau ’Properties’ → Remove Keyframe
Donc pour modifier une image ou une vidéo définitivement sans qu’elle varie dans le temps, il faut modifier

ces valeurs sur sa première image.

3.5 Panneau ’Video Preview’
Ce panneau permet de lire la vidéo que vous avez monté, à partir de la position du curseur. Pour lire toute

la vidéo, placez le curseur sur la première image (00 : 00 : 00 : 01), puis cliquez sur play (triangle en dessous de
l’image). Lorsqu’il n’est pas en mode lecture, l’image montrée est celle au moment de la position du curseur :
faites attention à mettre le curseur à la bonne position lorsque vous modifiez une image ou une vidéo pour
voir les effets en temps réel !

3.6 Retour sur la ’Timeline’
Revenons sur le panneau ’Timeline’. Il y a beaucoup d’actions qui peuvent être faites directement sur la

timeline sans passer par la panneau ’Properties’.

3.6.1 Déplacer une ressource dans la timeline

Si vous souhaitez déplacer une vidéo, une image ou un son dans le temps, il suffit de la glisser horizontale-
ment.

3.6.2 Raccourcir une ressource de la timeline

Pour raccourcir une vidéo une image ou un son, placer la souris à la fin (ou au début...) de la ressource
sélectionnée, une double flèche apparaît à la place de la souris. Vous pouvez alors faire glisser l’extrémité de
la ressource pour modifier sa durée.

3.6.3 Supprimer une ressource de la timeline

Pour supprimer une ressource présente dans la timeline, il suffit de la sélectionner et taper sur la touche
supprimer du clavier, ou clique droit → − Revove Clip.

3.6.4 Couper une ressource de la timeline

Pour couper une image, un son ou une vidéo, sélectionner les ciseaux en haut à gauche du panneau ’Timeline’
puis cliquer à l’endroit ou vous souhaitez

3.6.5 Accelerer/ Ralentir une ressource de la timeline

Vous pouvez accélérer our ralentir une vidéo ou un son, sélectionner la ressource dans la timeline puis
clique-droit → Time → Fast (pour accélerer) ou Slow (pour ralentir) → vitesse.

3.6.6 Séparer l’audio d’une vidéo

Il est possible de détacher l’audio d’une vidéo. Ainsi vous pouvez décaler le son, ou le supprimer pour le
remplacer par un autre son. Vous pouvez le détacher soit en mono, soit en stéréo. Je vous conseille de vous
simplifier la vie et de le faire en mono. Pour cela, il faut sélectrionner la vidéo dans la timeline, clique-droit
sur la vidéo → Separate Audio → Single Clip (all channels). La piste son ira automatiquement sur la piste
juste en dessous de la vidéo (attention donc à ce que la piste soit libre avant de faire cette action).

6



3.6.7 Transitions

Si vous mettez deux vidéos à la suite, elles vont se coller l’une après l’autre si vous les approchez (grace
à l’aimant toujours sélectrionné en haut à gauche de la timeline). Si vous voulez un enchainement avec une
transition de type ’fondu enchainé’, il suffit de placer la deuxième vidéo légerement sur la première sur la
première piste : elle se superposent. Il apparaît alors une zone bleu à l’endroit de la superposition : c’est la
transition. Vous pouvez l’étirer pour la faire durer plus longtemps, ou si vous la sélectionner, vous pouvez ne
modifier les propriétés.

A tout moment vous pouvez annuler vos dernières actions en allant dans le menu Edit →
Undo.

4 Lien vers quelques tutoriels youtube
Il ya un grand nombre de tutoriel, plus ou moins bien fait et de niveau variable. Je vous conseille de

commencer par les tutoriels ’débutant’ et les plus récents (2019) pour éviter de tomber sur les anciennes
version de logiciel.
• https://www.youtube.com/watch?reload=9&v=WXlZnN7c9Po (tuto débutant)
• https://www.youtube.com/watch?v=IsXcKH7eZJE (tuto un peu plus avancé)
• https://www.youtube.com/results?search_query=openshot+video+edtor (liste de tutos)

5 Liens vers images son et vidéos libres de droit
La propriété intellectuelle des images, dessins, photos, musiques et vidéos est un sujet important lorsque

vous réalisez vos vidéos, en particulier lorsque vous souhaitez la diffuser. Avant d’utiliser les ressources, assurez
vous de la licence sous laquelle elles sont publiées. Et de même, pensez à déclarer votre oeuvre sous une licence
pour permettre sa diffusion, son utilisation etc... La licence la plus connue (celle utilisée dans la plupart des
lien ci-dessous) est la licence Creative Commons (CC). Elle regroupe plusieurs licences qui dépendent si vous
souhaitez modifier la ressource ou non, l’utiliser à des fins commerciales ou non, ect... Il est important de garder
cette notion de propriété intellectuelle bien en tête, et je vous invite à parcourir la page wikipedia associée :
https://fr.wikipedia.org/wiki/Licence_Creative_Commons pour plus de détails. Voici les principales :
• CC0 1.0 : Dédié au domaine public universel. Aucun droit d’auteur applicable. Habituellement, le pro-

priétaire du droit d’auteur a dédié le fichier à l’usage public, ou le droit d’auteur lui-même a expiré. Vous
pouvez télécharger, utiliser, remixer, partager et faire tout ce que vous voulez sans avoir à mentionner
l’artiste.
• CC-BY 2.0 : Attribution Générique. Tout comme ci-dessus, mais vous devez fournir un lien d’attribution

à l’artiste original (donner le crédit à l’auteur).
• CC-BY-SA : Diffusion sous la même licence. Tout ce qui utilise le morceau de musique sous licence de

cette manière doit être mis à disposition sous la même licence.
• CC-BY-NC : Non Commercial. Vous ne pouvez pas utiliser la ressource dans tout ce qui est destiné à

un gain commercial sans l’autorisation écrite de l’auteur.
• CC-BY-ND : Attribution-NoDerivs. Toute ressource publiée sous cette licence ne doit pas être modifiée

de quelque manière que ce soit, y compris en l’utilisant comme bande sonore d’une vidéo pour une
musique par exemple.

5.1 Photos, images et illustrations (et parfois vidéos)
• http://www.freeimages.co.uk/
• https://www.reshot.com/
• https://pikwizard.com/
• https://visualhunt.com/
• https://unsplash.com/
• https://www.pexels.com/fr-fr/
• https://www.istockphoto.com/fr
• https://pixabay.com/illustrations/
• https://fr.freepik.com/
• https://www.istockphoto.com/fr
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5.2 Musique et sons
• https://freesound.org/
• https://freepd.com/
• https://freemusicarchive.org/
• http://dig.ccmixter.org/
• https://audionautix.com/
• https://incompetech.com/
• https://musopen.org/
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